
Nikon View 4 Reference Manual
For Version 4.3.1

Overview (pp. 2–3)

Getting Started (pp. 4–12)

Tutorial (pp. 13–32)

Preferences (pp. 33–42)

Appendices (pp. 43–51)



2Overview

Overview
About This Manual

Welcome to Nikon View 4!  Using Nikon View 4, you can connect your
Nikon digital camera to a computer or insert the camera memory card in
a card reader or PC card slot and browse photographs or save them to
disk.  Images can be transferred directly from the camera to the computer
via an IEEE 1394 or USB connection, or you can insert the camera memory
card in a card reader or PC card slot and copy images to disk.  The photo-
graphs to be viewed or copied to disk can be chosen from a list of thumb-
nail images (note that Nikon View 4 can not be used to browse images after
they have been transferred to disk; to browse images on disk, use
FotoStation Easy or the full version of Cumulus 5.0 or similar software).

Nikon View 4 version 4.3.1 can be used with the following Nikon digital
cameras: D1, D1X, D1H, COOLPIX5000, 995, 885, 775, 990, and
COOLPIX880.  For information on using these cameras, see the documen-
tation provided with the devices.

Please read all instructions in this manual thoroughly to ensure that you get
the most from Nikon View 4 and your Nikon digital camera.

Trademark Information

Microsoft and Windows are registered trademarks of Microsoft Corporation in the
United States of America and other countries.  IBM is a registered trademark of
International Business Machines.  Adobe and Adobe Photoshop are trademarks or
registered trademarks of Adobe Systems, Inc. Pentium, and Celeron are trademarks
of Intel Corporation.  Macintosh, Mac OS, and QuickTime are trademarks of Apple
Computer, Inc.  Cumulus is a registered trademark of Canto Software , Fotostation
Easy and Fotostation are registered trademarks of Fotoware A/S.  All other trade
names mentioned in this manual or other documentation provided with your Nikon
product are trademarks or registered trademarks of their respective holders.

Reading This Manual
This manual describes how to work with the images stored on your camera's
memory card.  It is divided into the following four main chapters:

• Getting Started
Read this chapter for information on the type of system required to use
Nikon View and for complete installation instructions.

• Tutorial
The tutorial provides all the information needed to browse the images
on the camera memory card and copy them to disk.

• Preferences
This chapter describes the options available in the Nikon View Prefer-
ences dialog.

•  Appendices
Included in the appendices are instructions for uninstalling and rein-
stalling Nikon View, together with a visual index to the program's prin-
ciple windows, menus, and dialogs.

This reference manual has been written for users of both the
COOLPIX series and D1 series of cameras. We ask for your
understanding that certain parts of this manual may not apply
to your camera.
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To make it easier to find the information you need, the following symbols
and conventions are used:

Background Knowledge

This manual assumes familiarity with operations common to the Macintosh
and Windows operating systems. If you are in doubt about the meaning of
any of the terms used here, refer to the documentation provided with your
operating system.

Illustrations

This manual is for use with both the Windows and Macintosh versions of
Nikon View.  While the majority of the illustrations are taken from the
Windows version of the product (Windows Millennium Edition), save where
otherwise noted the operations described apply to both the Macintosh
and Windows versions.

Printing This Manual

If desired, portions of this manual can be printed for ease of reference using
the Print… command in the Adobe Acrobat Reader File menu.

Life-Long Learning

As part of Nikon’s “Life-Long Learning” commitment to ongoing product
support and education, continually-updated information is available on-line
at the following web-sites:

• For users in the United States of America: http://www.nikonusa.com/
• For users in Europe: http://www.nikon-euro.com/
• For users in Asia, Oceania, the Middle East, and Africa: http://www.nikon-asia.com/

Visit these sites to keep up-to-date with the latest product information and
general advice on digital imaging and photography.  For more information,
please contact your nearest Nikon representative.

http://www.nikon-image.com/eng/

This icon marks cautions, information that you should read before
use to prevent damage to your Nikon product.

This icon marks notes, information that you should read before us-
ing Nikon View.

This icon marks tips, information that you may find helpful when
using Nikon View.

This icon indicates that more information is available elsewhere in
this manual or in other documentation.

This symbol indicates that the cross-reference marked with the 
icon is to the Nikon View 4 Reference Manual (this manual).

Blue text indicates a link to another part of this manual or to the
World-Wide Web.  Click the text to follow the link.

http://www.nikon-image.com/eng/
http://www.nikon-asia.com
http://www.nikon-euro.com
http://www.nikonusa.com
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Getting Started
Installing Nikon View 4

Before You Begin (pp. 5–6)

Installation (p. 7)

Starting Nikon View (pp. 8–12)

About This Chapter

This chapter takes you step-by-step through the process of installing Nikon View 4 and supporting software.

Pg. For more information on:

49 Reinstalling Nikon View 4
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Before You Begin
System Requirements

Software updates

For the latest information and updates, visit the following web-sites:
• For users in the United States of America: http://www.nikonusa.com/
• For users in Europe: http://www.nikon-euro.com/
• For users in Asia, Oceania, the Middle East, and Africa: http://www.nikon-asia.com/

1 Only pre-installed versions supported.
2 Windows 98 does not support IEEE 1394 connection of D1 series cameras.
3 The camera may not function as expected when connected to IEEE 1394 or USB hubs.
4 Please see the web page address below for support information  concerning compatible boards.

Getting Started: Before You Begin

Windows
Before installing Nikon View 4, make sure that your computer system satisfies the following requirements:

Hard disk space
15 MB required for installation, with an additional amount equivalent to twice the capacity of the camera

memory card required when Nikon View 4 is running

Video resolution
640 × 480 pixels with 16-bit color (High Color) (800 × 600 pixels or greater with 24-bit color [True Color]

recommended)

IEEE 1394 interface
(D1series cameras) Only boards compliant with Open Host Controller Interface (OHCI) are supported3,4

USB
(COOLPIX5000/995/885/775/990/880)

Only built-in USB ports supported3

Miscellaneous CD-ROM drive required for installation

OS Windows 98 1,2 / Windows 98 Second Edition (SE)1, Windows Millennium Edition (Me)1,

Windows 2000 Professional 1 , Windows XP Home Edition 1 / Windows XP Professional 1

Memory (RAM) 64 MB (128 MB or more recommended)

CPU MMX Pentium or better

http://www.nikon-asia.com
http://www.nikon-euro.com
http://www.nikonusa.com
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Software updates

For the latest information and updates, visit the following web-sites:
• For users in the United States of America: http://www.nikonusa.com/
• For users in Europe: http://www.nikon-euro.com/
• For users in Asia, Oceania, the Middle East, and Africa: http://www.nikon-asia.com/

Macintosh
Before installing Nikon View 4, make sure that your computer system satisfies the following requirements:

1 Built-in Firewire (IEEE 1394) or USB interface required.
2 Users of Mac OS 8.6 will need to upgrade to version 1.3.5 of the Apple Computer USB driver, and version 2.3.3 of the Apple Firewire driver.
3 The camera may not function as expected when connected to IEEE 1394 or USB hubs.

OS Mac OS 8.62, Mac OS 9.0, Mac OS 9.1, Mac OS 9.2

Memory (RAM) 32 MB (64 MB or more recommended)

Hard disk space 15 MB required for installation, with an additional amount equivalent to twice the capacity of the camera

memory card required when Nikon View 4 is running

Video resolution 640 × 480 pixels with 16-bit color (thousands of colors) (800 × 600 pixels or greater with 24-bit color

[millions of colors] recommended)

Firewire interface
(D1 series cameras) Only built-in Firewire ports supported3

USB
(COOLPIX5000/995/885/775/990/880) Only built-in USB ports supported3

Miscellaneous CD-ROM drive required for installation

Getting Started: Before You Begin

Model iMac1, iMacDV1, Power Mac G3 (Blue & White) 1, Power Mac G4 or later1, iBook1, Power Book G3 or later1

http://www.nikon-asia.com
http://www.nikon-euro.com
http://www.nikonusa.com
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Installation
Installing Nikon View 4 and Supporting Software

Windows / Macintosh

If you have already completed installation, click here  for information on starting Nikon View 4.

The procedure for installing Nikon View 4 varies according to your operating system, make of camera, and the image database software you are using.   Click
the links below for complete installation instructions.  After reading these instructions, you will be returned to the present manual.

Getting Started: Installation

Camera Operating system

COOLPIX5000

COOLPIX995

COOLPIX885

COOLPIX775

COOLPIX990

COOLPIX880

FotoStation

Mac OS

Other image database software
(such as Cumulus)

Mac OS

Nikon D1

Nikon D1X

Nikon D1H

Windows Millennium Edition  (Me)
Windows 98 Second Edition (SE)
Windows 2000 Professional
Windows XP Home Edition / XP Professional

Mac OS

Windows Millennium Edition  (Me)
Windows 98 / 98 Second Edition (SE)
Windows 2000 Professional
Windows XP Home Edition
Windows XP Professional

Windows Millennium Edition  (Me)
Windows 98 / 98 Second Edition (SE)
Windows 2000 Professional
Windows XP Home Edition
Windows XP Professional
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Starting Nikon View 4
Starting Nikon View 4

Once installation is complete, Nikon View 4 will start whenever your Nikon
digital camera is turned on and connected to the computer, or when the
camera memory card is inserted in a card slot or in a CompactFlash card
reader connected to the computer.  Note that for the program to start on
insertion of a memory card, the memory card must be from one of the
following cameras: COOLPIX5000, 995, 885, 775, 990, 880, 950, 900s, 900,
800, 700, or a camera in the D1 series.  The program will not start on inser-
tion of memory cards from cameras other than those listed above.  Note
too that only one camera can be connected to the computer at a time.

If you would prefer that Nikon View 4 not start automatically, select Auto
launch : Disable in the Auto launch tab of the Preferences dialog (  34).

Auto Start

Nikon View 4 will confirm that a camera is connected or a memory card
inserted in a card reader or card slot and start automatically when:
• A supported camera is connected while on and with a memory card in

place
• A supported camera with a memory card in place is connected and

then turned on
• A memory card from a Nikon digital camera supported under Nikon

View 4 is inserted in a CompactFlash card reader or card slot

D1/D1X/D1H (IEEE 1394/Firewire interface)

COOLPIX5000/995/885/775/990/880 (USB interface)

Before connecting your camera to a computer
(Windows only)
When the camera is first connected to a computer, the computer must
“register” the camera.  If you have been using a D1 camera with Nikon View
DX or Nikon Capture, you will need to update the device drivers for the
D1 before you can use Nikon View 4.

For more information about device registration or updating the device
drivers for the D1, click here .

Connecting the Camera to a Computer
Turn the camera on and connect it to the computer.  For more information
on connecting your camera and on the cables required, see the documen-
tation provided with your camera.

To Users of Windows 2000 Professional
When installing, uninstalling or using Nikon View 4, log on as the “Adminis-
trator”.  You can also log on as the ”Power User” in order to use the
program, but not to install or uninstall the program.

To Users of Windows XP (Home Edition / Professional)
When installing, uninstalling or using Nikon View 4, log on as the “Com-
puter Administrator”.
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Using a Card Slot
When inserted in a PC-card adapter (available separately), the camera
memory card functions as a Type II PCMCIA ATA card, allowing images to
be read from the card.

Inserting a Memory Card
After removing the memory card from the camera, insert it in the adapter
as shown below.

Insert the adapter in a computer that supports ATA-RAM memory cards
and is equipped with a PCMCIA Type II-compatible card slot.

For more information, see the documentation for your computer.  De-
pending on your operating environment, it may be necessary to install driv-
ers, register the card with the system, or adjust settings to configure the
computer to read CompactFlash memory cards.  For details, see the docu-
mentation provided with your computer or operating system.
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ADAPTER

Using a Card Reader
Images on the memory card can also be viewed using a card reader.

Inserting a Memory Card
After removing the memory card from the camera, insert it in the card
reader and connect the reader to the computer.  For information on con-
necting the card reader, see the documentation provided with the device.

Card reader (USB interface)

Card reader

CompactFlash
memory card
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Unexpected Termination
Nikon View 4 will terminate and a warning will appear if any of the opera-
tions listed below are performed while Nikon View 4 is in use.  Click OK to
close the warning and exit Nikon View 4.

• If you turn the camera off while
data transfer is in progress, or
disconnect the cable connect-
ing the camera and computer,
the warning shown at right will
be displayed.

• If you remove the memory card
from the card slot or card
reader while data transfer is in
progress, the warning shown at
right will be displayed.

• If you reformat the memory
card while Nikon View 4 is in
use, the warning shown at
right will be displayed.

To avoid unexpected termination, we recommend that you exit Nikon View
4 either by selecting Exit from the File menu or by clicking the Exit
button in the Transfer window (  15).  Make sure that data transfer is
complete before exiting Nikon View 4.

.

The Camera or Memory Card Drive or Volume
Connecting the Camera and Inserting Memory Cards
When a COOLPIX5000/995/885/775 digital camera is connected or a
memory card inserted in a card reader or card slot:

Windows
The computer will show the camera or memory card as a new drive in the
My Computer window.  Opening the drive will reveal the folder “DCIM,”
which holds further folders (“100NIKON” or other folders with names
assigned by the user or automatically by the camera) containing images
taken with the camera. Note that when first connecting a camera to the
computer, the camera must be registered as a device with Windows (  8).

Macintosh
The camera or memory card will appear on the desktop as an untitled volume.
Opening this volume will reveal the folder “DCIM,” which holds further folders
(“100NIKON” or other folders with names assigned by the user or automati-
cally by the camera) containing images taken with the camera. (Note that
memory cards formatted on a D1 series camera will appear on the desktop
not as an untitled volume, but as a folder labeled “NIKON D1X”.)

Disconnecting the Camera and Removing Memory Cards
Before disconnecting or turning a COOLPIX5000/995/885/775 digital cam-
era off or removing a memory card from a card reader or card slot:

Windows Millennium Edition / Windows 2000 Professional
Click the “Unplug or Eject Hardware” icon in the taskbar and remove the
camera or memory card from the system.

Windows 98 / 98 Second Edition

Double click the My Computer icon, and select the removable disk corre-
sponding to the camera.  Open the File menu and select Eject.

Macintosh
Drag the untitled volume corresponding to the camera or memory card into
the Trash.(Note that memory cards formatted on a D1 series camera will
appear not as an untitled volume, but as a folder labeled “NIKON D1X”.)
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Restarting Nikon View 4
Nikon View 4 can be restarted using the methods shown below:

1. If you have turned the camera off, disconnected the interface
cable, or removed the memory card from the card reader or
card slot, you can restart the program by:
 • turning the camera on
 • reconnecting the camera
 • re-inserting the memory card

(Not applicable if Auto launch : Disable is selected in the Auto launch
tab of the Preferences dialog.)

2. If you exited Nikon View 4 while the camera and computer
were connected, you can restart the program by:

Windows

Selecting Programs > Nikon View 4 > Nikon View 4 from the Win-
dows Start menu.

Macintosh

Double clicking the Nikon View 4 icon, which may be found in the folder
Nikon Software : Nikon View 4.

The window which first appears when Nikon View 4 is started depends on
the settings in the Auto launch tab of the Preferences dialog.  If the Trans-
fer tool window (small) option is checked then the Image Transfer win-
dow will open when Nikon View 4 is started. This is the default option at
installation. If the Contact sheet window (large) option is checked then
the Thumbnail List window will open when Nikon View 4 is started.

Pg. For more information on:

34 Preferences: Auto Launch
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If the card that was present when Nikon View 4 was shut down can not be
detected when the program is started manually, the following warning will
be displayed. (Note that detection will not occur if the card is not in the
same camera, card reader or card slot as on the previous occasion.)

Click OK to close the error message. The Image Transfer Window, or the
Thumbnail List window will open.  If the Thumbnail List window opens no
thumbnails will be displayed.  Only options in the Preferences dialog and
the help option can be viewed; no other operations can be performed.

If you exited Nikon View 4 while the camera and computer were
connected, you can restart the program by:
 • turning the camera off and then on again
 • removing and then re-inserting the memory card
 • disconnecting and then reconnecting the camera

(Not applicable if Auto launch : Disable is selected in the Auto
launch tab of the Preferences dialog.)



13

Tutorial
Transferring Images to the Computer

About This Chapter

This chapter describes how to transfer images to the computer from the camera, card reader, or card slot, and outlines the operations that can be
performed in the Image Transfer and Thumbnail List windows.

The Image Transfer Window (pp. 15–18)

The Thumbnail List Window (pp. 19–32)
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Unless Auto launch : Disable is selected in the Auto launch tab of the
Preferences dialog, Nikon View 4 will start automatically when the camera
is connected to the computer and turned on, or a memory card from the
camera inserted in a card reader or card slot.  The Image Transfer or Thumb-
nail List window will appear.  You can choose which window appears at
start-up in the Auto launch tab of the Preferences dialog (  34).  Images
can be transferred to the computer from either window.

The Image Transfer window provides a convenient tool for transferring all
images, or all images of a specified type, to the computer in a single opera-
tion.  The Thumbnail List window gives you the opportunity to view images
before transfer and select the images that will be copied to your computer.

The Image Transfer Window
The Image Transfer window provides a simple
tool for transferring images to the computer
from a memory card inserted in a camera,
card reader, or PC card slot.  It also allows
access to the Thumbnail List, Preferences, and
Help windows.

The Thumbnail List Window
The Thumbnail List window can be used to browse images or view photo
information.  This window can be used to view as small thumbnail previews
of the images on the memory card inserted in the camera, card reader, or
card slot and select the images to be transferred to the computer, or to
preview selected images at full size.

Pg. For more information on:

34 Preferences: Auto Launch

Viewing Images on the Hard Disk

The Thumbnail list window can not be used to preview images that have
already been transferred to the hard disk.Using the Transfer Button (COOLPIX885/775)

Users of the COOLPIX885/775 can also transfer or upload images using the
TRANSFER button on the camera itself. Click here  for more information.

If you want to transfer images to the computer immediately with-
out altering any of the default settings such as the destination
folder, click here  .
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The Image Transfer Window
Using the Image Transfer Window

The following controls are available in the Image Transfer window (shown below):

The Macintosh version of Nikon View 4 has a
menu bar that duplicates the functions of the
tool buttons (the Windows version does not
have a menu bar).  Most operations can be per-
formed using the tool buttons and, in the case
of the Macintosh version, the menus in the menu
bar.  In the case of operations that can be per-
formed by means both of menus and tool but-
tons, the explanation in this manual gives prior-
ity to the tool buttons.

Tutorial: The Image Transfer Window

Specify the size of the image after transfer.  (  18)
Transfer size

Image transfer rule

Choose the type of image that will be transferred.  The type of image
selected appears in the text box below the button.  (  17)

Button Function

Transfer Transfer images of the selected type to the computer.  (  18)

Thumbnail list Open the Thumbnail List window.  (  21)

Preferences Open the Preferences dialog.  (  34)

Help Display help for Nikon View 4.  (  32)

Exit Exit Nikon View 4.  (  10)
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Sub-folders

When images are transferred to the computer, a sub-folder is created within the
selected folder and all images transferred to the sub-folder.  The sub-folder is named
according to the current date and time (YYYYMMDD-HHMMSS). For example, if
images were transferred to the computer on February 2nd 2002 at 22 hours 33
minutes and 44 seconds, the corresponding folder name would be 20020202-223344.

 Uploading Images to Nikon FotoShare

If your computer is connected to the internet, and you choose FotoStation
as your image database application, images that have been transferred to
the computer can be uploaded to Fotoshare, Nikon’s on-line photo album
service.  If you want to upload images to FotoShare, click here .
After reading Uploading Images to Nikon FotoShare (pages 17B-20B) you
will be linked back to page 19 of this manual.

 FotoStation Easy

The FotoStation Easy ‘Coolpix’ folder  is preset to browse to the default folder
to where Nikon View 4 transfers images. If you change the folder in Nikon View
4 you may have to quit Nikon View 4 and FotoStation and  then relaunch both
programs for FotoStation to find the new transfer destination folder.

Pg. For more information on:

35 Preferences: Transfer
40 Preferences: Database

Step 2—Choose an image database
If you will not be using image database software, proceed to Step 3.

Confirm that an image database application has been selected in the Data-
base tab of the Preferences dialog (  40).

Transferring Images Using the Image Transfer Window
This section describes how to use the Image Transfer window to transfer images to
your computer from a memory card inserted in a camera, card reader, or card slot.

Step 1—Choose a destination
In this step, you will choose the destination folder for the images that will be
transferred from the memory card.  Users who intend to transfer images to
the default destination can proceed to Step 3 (unless you have selected a new
default, the default destination is the Images folder in the folder to which you
installed Nikon View 4).  To change the destination, click the Change... button
in the Transfer tab of the Preferences dialog (  35) and choose a new folder.

The dialog above shows the Database tab when Cumulus is installed as the
image database software. If Cumulus is not installed, there will be no check
in the Register in image database box and the Select image data-
base software text box will be grayed out.  To select another image data-
base check the box, click Change... and navigate to the desired folder.
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After selecting an image type, click OK to return to the Transfer Image
window.  The selected image type will be indicated by an icon in the text
box below the Image transfer rule button.

Transfer Marked Images

COOLPIX5000/995/885/775 allow you to mark images intended for transfer,
although some cameras do not support this operation.  Consult the docu-
mentation provided with your camera.

Step 3—Choose the images to be transferred
In this step, you will choose the images to be transferred.  This allows you
to select only a specific type of image, for example protected images, for
transfer.  Click the Image transfer rule button in the Transfer Image
window.

The dialog shown below will be displayed, where you can select the type of
image to be transferred.

Check Save setting until next change is made to save the selected
type as the default setting for subsequent sessions of Nikon View 4.  If this
box is not checked, the default setting will be All Images (Ignore trans-
fer mark and protect attribute), and all images will be transferred.

Image transfer rule
button

All images will be trans-
ferred.  This is default set-
ting at installation.

All Images
(Ignore transfer mark
and protect attribute)

All images

Transfer Marked
images only

Only unmarked images will
be transferred.

Only protected images will
be transferred.

Transfer images with
Protect attribute

Transfer images with-
out Protect attribute

DescriptionSelection Icon

Only marked images will
be transferred.

Only unprotected images
will be transferred.

Transfer Unmarked
images only
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Step 5—Transfer the images
To transfer images of the selected type, click the “Transfer” button.

Transferring Images

The original image remains on the memory card when images are trans-
ferred to a computer.

Other operations within Nikon View 4 can not be performed while the
Transferring… window is being displayed.

A progress indicator will be displayed while the images are being trans-
ferred.  A thumbnail preview of the image currently being transferred will
also be displayed.  When multiple images are transferred, the Transferring…
window will include a progress meter showing the number of images cop-
ied to disk and the number of images remaining.

Step 4—Choose an image size
Choose a size suited to the task at hand from the Transfer size menu.

Aspect Ratio

If the original image does not have an aspect ratio of 4 : 3 (note that photo-
graphs taken with the D1, D1X , D1H or COOLPIX5000/995/990 have an
aspect ratio of 3 : 2), the vertical dimension will be adjusted to match the
horizontal dimension without changing the original aspect ratio.

If you choose At same size, image size will not change during transfer.  At
other settings, all images larger than the selected size will be converted to the
new size during transfer.  Images smaller than the selected size are trans-
ferred at their original size.  All photo information apart from the “image size”
field will be unaffected by the conversion.  Converted images are saved using
JPEG compression at a ratio equivalent to a camera setting of NORMAL.

The following options are available.

Transfer size menu

“Transfer” button

Images will be saved at their original dimensions.At same size

DescriptionOption

Images will be converted to XGA (suitable for dis-
play on most computer monitors).

1024 × 768
(Pixels)

Images will be converted to VGA (suitable for Web
distribution).

640 × 480
(Pixels)

Images will be converted to QVGA size (suitable
for distribution by e-mail).

320 × 240
(Pixels)
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The Thumbnail List Window
Using the Thumbnail List Window

The Thumbnail List window includes a menu bar, toolbar, a folder tree area and camera settings section, and a thumbnail list area.

Folder tree area
Shows the folders on the memory
card inserted in the camera, card
slot, or card reader (  23).

Camera settings section
Displays photo information for the
selected image (  27).

Thumbnail list area
Shows thumbnail previews of the im-
ages in the path indicated in the folder
tree .

Toolbar
Contains buttons for the operations
that can be performed in the Thumb-
nail List window.

Status bar
Gives the current folder name, the number of images in the folder, and the
number of images selected in the thumbnail list area.

Menu bar
Contains File, Edit, View, Image,
Camera, and Help menus (  44).
The Macintosh version also contains
a Window menu.

The majority of operations in the Thumbnail List window are performed using the menu bar and tool buttons.  In the case of operations that can be
performed by means both of menus and tool buttons, the explanation in this manual gives priority to the tool buttons.

Tutorial: The Thumbnail List Window
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The Thumbnail List window contains the following buttons:

Tutorial: The Thumbnail List Window

Transfer
Transfer the selected images to the
computer.  (  18)

Specify the size of the image after
transfer.  (  18)Transfer size

Progress
indicator

This display is active when an operation
is in progress.  (  32)

Help Open help for Nikon View 4.  (  32)

Choose the size at which thumbnails
will be displayed.  (  24)Thumbnail size

Toggle view
View or hide the folder tree area and/
or camera settings section.  (  23)

Button FunctionButton Function

Open
Opens the selected image(s) in the
built-in viewer or an external applica-
tion.  (  29)

Save copy
Save a copy of each of the selected
images. (  26)

Print Print the selected images.  (  26)

Delete
Delete the selected images (  28) or
folders.  (  31)

90° CCW
Rotate the selected image ninety de-
grees to the left.  (  27)

90° CW
Rotate the selected image ninety de-
grees to the right.  (  27)

Preferences Open the Preferences dialog.  (  34)
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Transferring Images Using the Thumbnail List window
Using the Thumbnail List window, you can select images to be transferred
to the computer from the memory card inserted in the camera, card slot,
or card reader.

The following explanation assumes that you have completed steps 1–2 of
“Transferring Images Using the Image Transfer Window.”  See “Tutorial: Trans-
ferring Images Using the Image Transfer Window” steps 1–2 (  16).

Step 1—Open the Thumbnail List window
When the camera is connected to the computer and turned on, or a memory
card from the camera inserted in a card reader or card slot, Nikon View 4
will start automatically and the Transfer Images or Thumbnail List window
will appear.  You can choose which window appears at start-up in the Auto
launch tab of the Preferences dialog (  34).  Images can be transferred to
the computer from either window.

If the Transfer Images window is displayed, you can open the Thumbnail List
window by clicking the “Thumbnail list” button.

Step 2—Choose a folder

Pg. For more information on:

34 Preferences: Auto Launch

If the memory card contains only one folder with images, the Thumbnail list
will automatically open with that folder selected and thumbnails of the
images in the folder displayed.  Where there is more than one folder, the
images in the first folder will be previewed automatically.

“Thumbnail list” button

The folders on the memory card are
shown in the folder tree area.  Click the
folder containing the desired images;
thumbnail previews of the images in the
folder, including hidden images, will be dis-
played in the thumbnail list area.



22

Step 3—Select images
Select the images that you wish to transfer to the computer.  Selected
images are highlighted with a yellow border.

To select multiple images, press the Ctrl (Windows) or Command
(Macintosh) key while clicking each image in turn.  A group of images can be
selected by dragging the mouse.  Press the shift key while clicking two
images to select the images and all images between them.

Step 4—Transfer the images
To transfer the selected images to the computer, click the “Transfer” button.

A progress window will be displayed as described above under Step 5 of
“Transferring Images Using the Image Transfer Window” (  18).

Tutorial: The Thumbnail List Window

“Transfer” button

Selected image
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Working with Thumbnails
This section describes the operations that can be performed on thumb-
nails.

Choosing a Folder
The folders on the memory card are shown in the folder tree area.  Click
the folder containing the desired images; thumbnails of the images in the
folder will be displayed in the thumbnail list area.

Tutorial: The Thumbnail List Window

By clicking the “Toggle view” button in the folder tree area, you can display
or hide the folder tree area and camera settings section.  The display will
cycle through views as follows: both folder tree area and camera settings
section displayed → folder tree area displayed, camera settings section hid-
den → folder tree area hidden, camera settings section displayed → both
folder tree area and camera settings section hidden → both folder tree
area and camera settings section displayed.

If only one folder is present on the memory card and you do not need to
view photo information, you can hide both the folder tree and camera
settings section to increase the size of the thumbnail list area and the num-
ber of thumbnails visible.

Selecting Thumbnails
Thumbnail previews of the images in the selected folder are shown in the
thumbnail list area.  To select multiple images, press the Ctrl (Windows) or
Command (Macintosh) key while clicking each image in turn.  A group of
images can be selected by dragging the mouse.  Press the shift key while
clicking two images to select the images and all images between them.

Selected image

Selecting Multiple Images

The commands in the Select sub-menu of the Edit menu can be used to
select all images of a specified type (transfer marked or unmarked, pro-
tected or unprotected).

“Toggle view”
button
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Specifying Thumbnail Size
The pull-down menu at the right side of the Thumbnail
List window can be used to specify the dimensions of
the thumbnails displayed in the thumbnail list area.
When a new size is chosen, any images that were se-
lected or rotated before the change will still be se-
lected or rotated at the new size.

The following five sizes are available:
• 64 × 64 pixels
• 96 × 96 pixels
• 128 × 128 pixels
• 192 × 192 pixels
• 256 × 256 pixels

The default size at installation is 96 × 96.  At sizes of 96 × 96 and 64 × 64, no
file-status icons are displayed.  At a size of 64 × 64, the file type extension is
not displayed.

Examples of the thumbnail list at different thumbnail sizes are shown below.

Tutorial: The Thumbnail List Window

File Names

Images taken with the COOLPIX5000, 995, 885, 775, 990 and 880 will have
a file name of the form “DSCNXXXX.JPG”.  Images taken with a D1 series
camera will have a file name of the form “DSC_NNN.JPG”.  Small Pictures
taken with the COOLPIX885 will have a file name of the form
”SSCNXXX.JPG”.

64 × 64 (file name only—no extension or file-status icon displayed)

96 × 96 (file name and extension only—no file-status icon displayed)

128 × 128 or more (file name, extension, and file-status icon displayed)
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File Status
Hidden and protect status can be assigned to or removed from images
using the Attribute sub-menu, which may be found in the Image menu.
The Macintosh version of Nikon View 4 can be used to change the protect
status of images, but not their hidden status.

When a thumbnail size of 128 × 128 or more is selected, icons indicating
transfer marked and protected status appear to the left of the file name.  A
movie icon appears in the case of movie files.  No icon appears in the case
of hidden images. Hidden image status can be confirmed in the settings
section of the Thumbnail List window (Windows only).

Printing the Thumbnail list and Saving It to Disk
To print the currently selected thumbnails, choose Print Thumbnail list
from the File menu.  The file name and date and time of recording will be
printed below each thumbnail.  Any rotations will be reflected when the
thumbnail is printed.  If desired, this output can be saved to disk as a JPEG
file by selecting Copy thumbnail list to file from the File menu.  The file
will automatically be assigned the name Sheet+(page number).JPG.

Displaying the Image Transfer Window
In Nikon View 4, the Image Transfer window can be opened from the Thumb-
nail List window by selecting Display Small Transfer Window from the
View menu.

Movie file

Protected file

Transfer Marked file

DescriptionIcon

Hide sub-menu Protect sub-menu

Protect icon File name

Click here
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Saving Images
After selecting the image or images you wish to save from the thumbnail
list, click the “Save copy” button.  A dialog will appear where you can navi-
gate to the volume (disk) and folder to which you wish to save copies of
the images.  The original image will remain on the memory card inserted in
the camera, card slot, or card reader.

Working with Images
This section describes the operations that can be performed on images.

Transferring Images to the Computer
In the thumbnail list area, select the image or images you wish to transfer.
Copies of the images will be transferred to the computer when the “Trans-
fer” button is clicked.  Transfer does not affect the originals on the memory
card inserted in the camera, card slot, or card reader.   Depending on user
settings, any rotations and size changes may apply when the images are
transferred, and transferred images may be catalogued using the selected
image database software.

A progress window will be displayed as described above under Step 5 of
“Transferring Images Using the Image Transfer Window” (  18).

Printing Images
In the thumbnail list area, select the image or images you wish to print.
Click the “Print” button to print the images at their original size.  Print-outs
can not be made from movie files.

The copies created by this operation are identical to the original images on
the memory card, and do not reflect rotations or size changes made in the
Thumbnail List window.  Captions and keywords are not included, and the
images will not be catalogued or registered in a database as they are saved.
In the Macintosh version of Nikon View 4, if the Create thumbnail option in
the Transfer tab of the Preferences dialog is checked, a thumbnail icon for
each transferred image will be created for display in the Finder (  38).

“Transfer” button

“Save copy” button

“Print” button

Select the folder to which you wish
to save the copies and click OK.
Copies of the selected images will
be saved in the selected folder.

In the Macintosh version, select the
desired folder and click Save.

Copying Images to Disk by Drag and Drop

Images can also be copied to disk by dragging and dropping the selected
thumbnails onto the desktop or another folder.
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Rotating Images
Select the image or images you want to rotate from the thumbnail list and
click the “90° CCW” or “90° CW” button.

Any rotations will be reflected in the thumbnail images.

“90° CCW” button

“90° CW” button

Image rotated
clockwise

Image rotated
counter-clockwise

Pg. For more information on:

29 Viewing Still Images

Rotations do not apply to the original images on the memory card inserted
in the camera , card slot, or card reader, but will be visible in images opened
in the still-image viewer.  The image will also be rotated when transferred
to the computer.  Movie files and their associated thumbnails and images
displayed as file icons can not be rotated.

Viewing Photo Information
When a single thumbnail is selected,
photo information will be displayed
in the camera settings section.  Photo
information is not displayed when no
thumbnail is highlighted or when
multiple thumbnails are selected.

The camera settings section can be
displayed or hidden using the “Toggle
view” button.  The information in the
camera settings section can be se-
lected and copied to the clipboard.

The information displayed includes
the following items.  If no informa-
tion is available for a given setting,
“N/A” will be displayed.

COOLPIX990/880 Movies

Only the following data is displayed: Thumbnail data, File name, File size,
Date and time, Number of bits, Protection Attribute, Hide Attribute.

• File Name
• File Size
• Date Taken
• Image Size
• Resolution
• Number of Bits
• Protection Attribute
• Hide Attribute (Windows only)
• Camera ID
• Camera
• Quality Mode
• Metering Mode
• Exposure Mode
• Flash
• Focal Length
• Shutter Speed
• Aperture

• Exposure Compensation
• White Balance
• Lens
• Flash Sync Mode
• Exposure Difference
• Flexible Program
• Sensitivity (ISO equivalency)
• Image Sharpening
• Image Type
• Color Mode
• Hue Adjustment
• Saturation Control
• Tone Compensation
• Latitude (GPS)
• Longitude (GPS)
• Altitude (GPS)
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Deleting Images
After selecting the image or images you want to delete in the thumbnail list
area, click the “Delete” button.

If the selection does not include any protected images, the following dialog
will be displayed.  Click OK to delete the selected images.

If the selection includes protected images, the following dialog will be dis-
played.  Click OK to delete all selected images, including those that are
protected.

“Delete” button

Deleted Images

Images selected for deletion are permanently erased from the memory card
inserted in the camera, card slot, or card reader, and can not be recovered.
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Viewing Images
Viewing Still Images
Double-click any of the highlighted images to open each of the selected
images in a separate window.  The folder and file name will be displayed in
the title bar, separated by a backslash (Windows) or colon (Macintosh).
The following buttons are located at the bottom left corner of the window:
“90° CCW,” “90° CW,” “Zoom out,” and “Zoom in.”  The status bar shows
the width and height of the image in pixels, the current zoom ratio, and the
amount of rotation currently applied to the image.

Tutorial: The Thumbnail List Window

Scrolling Images
Areas of the image that do not fit in the window can be viewed by dragging
the image with the hand cursor ( ) or by scrolling the image with the
scroll bars at the bottom and right side of the window.

Rotating Images
Images can be rotated ninety degrees at a time in either direction using the
rotate buttons at the bottom left corner of the window.

Zooming the Image in or Out
Use the zoom in and zoom out buttons to zoom the image in or out.  If you
press the Alt (Windows) or option (Macintosh) key while the cursor is
over the image window, the cursor will change to the zoom-out cursor
( ).  Click anywhere in the window while the zoom-out cursor is dis-
played to zoom out.  To zoom in, press the Ctrl (Windows) or command
(Macintosh) key while the cursor is over the image window (the zoom-in
cursor ( ) will be displayed) and click anywhere on the image.  The mini-
mum zoom ratio is 1 : 8, the maximum ratio 8 : 1.

Selecting a Still-Image Viewer

The application used to view still images can be selected from the Viewer
tab in the Preferences dialog.

Pg. For more information on:

42 Preferences: Viewer

“90° CW” button

“Zoom out” button
“Zoom in” button

“90° CCW” button
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Viewing Movies
Movies can be played back by clicking the associated thumbnail.

Choosing a Movie Player

The application used for playing movies can be selected using the Viewer
tab of the Preferences dialog.

Pg. For more information on:

42 Preferences: Viewer

Macintosh
In the Macintosh version of Nikon View 4, movies can be played back using
the built-in player or in any external application that supports Quick Time
movies.  At installation, the default external application is the Quick Time
Player.  For details, see the documentation provided with the movie player
application.

Choosing a Movie Player

The application used for playing movies can be selected using the Viewer
tab of the Preferences dialog.

Pg. For more information on:

42 Preferences: Viewer

Windows
Movies can be played back using any application that supports Quick Time
movie files with the “.MOV” extension, usually Quick Time Player.  If Quick
Time Player is not installed on your computer install Quick Time 4.1.2,
whick is included with the COOLPIX version of Nikon View 4.  For details,
see the documentation provided with the movie player application.
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Deleting Folders
To delete a folder and all images it contains, select the folder in the folder
tree area and click the “Delete” button.

If the folder contains protected images, the following dialog will be dis-
played.

Clicking OK deletes the folder and all images it contains (including pro-
tected images).

If the folder contains no protected images, the following dialog will be dis-
played.  Click OK to delete the selected folder.

Other Operations
This section describes the other operations that can be performed in the
Thumbnail List window.

Formatting Memory Cards
Memory cards inserted in a card reader or card slot, or in a COOLPIX5000/
995/885/775/990/880 connected via USB, can be formatted by selecting
the card reader icon in the folder tree area and choosing Format card
from the Camera menu.  Depending on your operating system, one of the
following dialogs will appear.  Click Start (Windows) or OK (Macintosh)
to format the memory card.  The procedure for formatting memory cards
inserted in cameras in the D1 series is the same as that  when formatting
cards from the camera.

“Delete” button

Deleted Folders

Once deleted, folders and their contents can not be recovered.

Formatting Memory Cards

Formatting memory card permanently deletes all data they contain.  Note
that clicking OK in the dialog that is displayed when formatting is complete
will exit Nikon View 4.

Macintosh

Windows
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Task Confirmation
When a task is in progress, the segments of the progress indicator light up
in sequence.  Do not perform any other operations until the current task is
complete.

Viewing Help
For information on using Nikon View 4, click the “Help” button.  The help
file will be displayed.

The help file can be viewed using basic Windows or Macintosh operations.
For details, refer to the documentation provided with your operating system.

Tutorial: The Thumbnail List Window

“Help” button
Progress indicator
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Preferences
Fine-Tuning Nikon View 4

About This Chapter

This chapter describes the options available in the Nikon View 4 Preferences dialog.

The Preferences Dialog (p. 34)

The Auto Launch Tab (p. 34)

The Transfer Tab (pp. 35–39)

The Database Tab (p. 40)

The File Information Tab (p. 41)

The Viewer Tab (p. 42)
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The Preferences Dialog
Adjusting Preferences

The Preferences dialog can be opened by clicking the “Preferences” button
in the Transfer Images and Thumbnail List windows.

Preferences: The Preferences Dialog

The Preferences dialog contains the following five tabs:  Auto launch, Trans-
fer, Database, File information and Viewer. Changes to settings take effect
not as they are made, but only when the OK button at the bottom of the
Preferences window is clicked.  Clicking Cancel closes the Preferences
dialog and returns settings to the values in effect when the dialog was
opened.

The Auto Launch Tab
Start-up Options for Nikon View 4

The Auto launch tab allows you to adjust start up settings for Nikon View 4.
Use Auto launch to set whether Nikon View 4 starts automatically when a
camera is connected to the computer and turned on, or when a memory
card is inserted into a card reader or card slot. Check Enable, and Nikon
View 4 will start automatically under the above conditions. Check Disable,
and Nikon View 4 will not start automatically.

Initial screen sets the window to be displayed when Nikon View 4 is
started up.  Check Transfer tool window (small) to display the Image
Transfer window; check Contact sheet window (large) to display the
Thumbnail list  window.

“Preferences” button
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The Transfer Tab
Specifying a Destination and File Names for Transferred Images

The Transfer tab is where you specify the destination and file names for images transferred to the computer.  There are a few differences between Transfer
tabs for the Windows and Macintosh versions of Nikon View 4.

Windows Macintosh

Preferences: The Transfer Tab
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Select Destination
This area of the Transfer tab is used to specify the destination folder for
images transferred to the computer.

File Naming
This area of the Transfer tab is where you specify how files will be named
when transferred to the computer.  You can opt to use either the file name
assigned automatically by the camera when the image was taken (Keep
original file name) or a name automatically generated by the computer
as images are transferred to disk (Create new file name).  If Create
new file name is selected, you can specify how file names will be assigned
using the options in the File name creation rule section.

The default destination at installation is the Images folder in the folder to
which Nikon View 4 has been installed.  To change the destination, click the
Change... button,  If the image database software selected in the Database
tab uses a registration folder rather than a catalog to track images, the
Change… button will be grayed out and unavailable.    If a new destination
folder is specified, but has been deleted, the destination will automatically be
changed to the Images folder and the following warning will be displayed.

Preferences: The Transfer Tab
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File-Naming Conventions

The maximum length for file names varies with the operating system.  If the
file name exceeds the limit for your operating system, characters will be
trimmed from the right end of the prefix or suffix.

For example, if Nikon is selected as the prefix, Date and Time of cre-
ation is chosen for the content, and 99 is chosen as the starting file num-
ber, the first file transferred to the computer will have a file name such as
NIKON010307105516_99.JPG.

Sample
The sample reflects the results of the selected file-naming options.  The ex-
ample below shows the sample that will be generated when NIKON is se-
lected as the prefix and Date and time of creation chosen for the content.

Extensions

Depending on the file type, one of the following extensions will be assigned:

Preferences: The Transfer Tab

File Name Creation Rules
File names created automatically by the computer consist of a prefix or
suffix (optional), content, and file numbers assigned automatically in ascend-
ing order.  An extension is assigned automatically according to the file type.

File names
File names generated by Nikon View 4 take the form shown below.  File
names may include either a prefix or a suffix, but not both (you can also opt
to use neither a prefix nor a suffix). Note also that an underscore is added
before the file number.

(prefix) + (content) + _file number + (suffix) + extension

File name creation options
Prefix/Suffix
You can choose one of Use prefix, Use suffix, and Neither.  If Use
prefix or Use suffix is selected, you can enter a prefix or suffix of up to
eight characters in the text box.  The prefix is added to the beginning of the
file name (before the content), the suffix at the end (before the extension).

Contents
You can select one of None, Use folder name, Use original file name,
and Date and time of creation.  If Use original file name is selected,
the Sequential numbering option will be grayed out and unavailable.

Sequential numbering
You can enter a starting number of up to 999999 for sequential file num-
bering.  The specified number will be assigned to the first file transferred to
the computer after the setting is made, after which the file number will be
incremented by one for each file transferred.  File numbering will automati-
cally return to zero after 999999 has been reached.  File numbering also
returns to zero whenever the Reset button is clicked.

File type Extension File type Extension

JPEG .JPG
NEF

(RAW data)
.NEF

TIFF .TIF
Quick Time

movie
.MOV

Prefix Content    Sequential numbering
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Windows

The following options are available only in the Windows version of Nikon
View 4.

Save hidden image
If this box is checked (the default setting at installation),  hidden images will
be saved together with other images when files are transferred to the com-
puter using the transfer window.  If the box is not checked, hidden images
will not be transferred to the computer when files are transferred to the
computer using the Image Transfer window.  The Save hidden image
option has no effect on transfer and save operations performed in the
Thumbnail List window; all images, including hidden images, selected in the
Thumbnail list window will be transferred whether or not the Save hid-
den image box is checked.

Display thumbnail during transfer
When this box is checked (the default setting at installation), a thumbnail
preview of each of the images transferred will be displayed while the file is
copied to the computer.

Pg. For more information on:

17 Image transfer rule

File Icons

If Create thumbnail is not checked, image files will automatically be as-
signed a file icon for the application associated with other files of the same
type.  If no application is associated with files of the appropriate type, the
file will have an empty icon.

Preferences: The Transfer Tab

Macintosh

The following options are available only in the Macintosh version of Nikon
View 4.

Create thumbnail
When this box is checked (the default setting at installation), a thumbnail
icon is generated for each image as it is transferred.  This icon will be shown
when Icon is selected in the Finder View menu.

Display thumbnail during transfer
When this box is checked (the default setting at installation), a thumbnail
preview of each of the images transferred will be displayed while the file is
copied to the computer.
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 Macintosh

The following options are available only in the Macintosh version of Nikon
View 4.

Select a helper application for each file format
The buttons in this area are used to select the applications associated with
files transferred to the computer.  The selected applications will start when
files are double-clicked in the Finder after transfer.  Separate options are
available for still images (JPEG and TIFF files), NEF image (RAW data), and
movies.  Click the Change… button to choose the associated application.

During installation, Nikon View 4 will search for existing applications and
automatically associate the above file types with the following defaults:

Still images (JPEG/TIFF)

Preferences: The Transfer Tab

NEF images (RAW data)

Photoshop present
at installation?

Default viewer selected at installation

Yes Photoshop

No Quick Time Picture Viewer

Application present at installation Default viewer selected
at installationPhotoshop Nikon Capture

Nikon CapturePresent Present

PhotoshopPresent Not Present

Nikon CaptureNot Present Present

Nikon CaptureNot Present Not Present

Movie
Quick Time Player
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Select image database software
If the selected image database application catalogs images in a file, you will
be prompted to select the catalog file used.  If it instead catalogs images in
a folder, you will be prompted to select a registration folder.  Be sure that
the application selected is supported under Nikon View 4 (  16).

Select catalog file
This option is available if the selected image database application creates a
catalog file containing image information supplied by Nikon View 4 as the
images are transferred to the computer (Cumulus 5.0 and iView MediaPro
1.0 are examples of this type of database application).  To specify the file
used to catalog transferred images, click the Change… button.  To create
a new catalog file containing no image data, click New….

Select registration folder
This option is available if the selected application creates an image database
by copying images to a folder (PC-Archive [Windows only] is an example of
this type of database application). To select the folder used, click the
Change… button.

Preferences: The Database Tab

The Database Tab
Choosing an Image Database Application

Nikon View 4 can not be used to view images that have been transferred to the
computer.   Images that have already been transferred to the computer  may be
viewed using an image database application, a convenient tool for organizing
your pictures. The Database tab contains options for choosing an image data-
base application and the catalog file or registration folder used to catalog images
as they are transferred.  Note that when using FotoStation Easy as the image
database application, FotoStation Easy need not be selected from the Database
tab since images transferred to the computer will be opened automatically in
this application if it is installed.  When the Register in image database box is
checked, images will be registered in an image database as they are transferred.
The selected image database application can be changed by clicking the Change…
button next to the Select image database software textbox.

If Cumulus was installed as the image database software before Nikon View
4 was installed, the Database Tab will appear as shown above.

Registration Folders

If a registration folder is selected, the Select destination text box in the
Transfer tab of the Preferences dialog will show the selected folder. Trans-
ferred files will be saved to this folder.
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Keywords
When Nikon View 4 transfers image data to the computer, keywords can
be attached to image data files.You can specify up to ten keywords of up to
thirty-one characters in length to be included with the transferred files.
Enter a keyword in the text box after checking the box to its left.

When a file including keywords is transferred to the computer, keywords
can be viewed in the file information or file properties windows of applica-
tions such as Photoshop (version 5.0 or later).  Keywords can also be viewed
with image database software.

Keywords are not included with movie files or images displayed as a file icon.

The File Information Tab
Including Information with Transferred Images

Copy camera settings to Caption field
When Nikon View 4 transfers image data to the computer, photo informa-
tion can be included in the photo caption.  When the Copy camera set-
tings to Caption field box is checked (the default setting at installation),
photo information will be included.  Photo information will only be added
to the database if this box is checked.

Preferences: The File Information Tab

When Copy camera settings to Caption field is checked, photo infor-
mation for still images is copied to the caption.  The caption can be viewed
in the file information or file properties windows of applications such as
Photoshop (version 5.0 or later).  Captions can also be viewed with image
database software.

A caption is not created in the case of movie files or images displayed as a
file icon.
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The Viewer Tab
Options for the Thumbnail List Window

Create large thumbnails from image data
When this box is checked, a large thumbnail preview will be generated
when data for such a thumbnail does not exist in the original file.  Note that
this will increase the amount of time needed to display thumbnails.  The
default for this option is off.

Select still image viewer
You can choose the viewer for still images from the viewer included with
Nikon View 4 (Nikon View) or a third-party application such as Adobe
Photoshop (Other program).  When Other program is selected, the
application used to view still images can be chosen by clicking the Change…
button.  The default option at installation is Nikon View.

Select movie player
The options in this section are used to select the player for viewing movies.

Windows

Click the Change… button next to the Select movie player text box
to choose the application used to play movie files.

Macintosh

You can choose a movie player from the player included with Nikon View 4
(Nikon View) or a third-party application (Other program).  When
Other program is selected, the application used to play movies can be
chosen by clicking the Change… button.  The default option at installation
is Nikon View.

Preferences: The Viewer Tab

Large Thumbnails

Large thumbnails for high-resolution thumbnail display are included in still
images taken with the D1X, D1H, or COOLPIX5000/995/885.  Large thumb-
nails are not included in images taken with the D1 or COOLPIX775/990/880.

When data for a large thumbnail exists in the original image file, standard
size thumbnails will be generated from the large thumbnail, irrespective of
the above setting.
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Appendices

Nikon View 4 Visual Index (pp. 44–47)

Troubleshooting (p. 48)

Reinstall (pp. 49–51)

About This Section

The appendices provide:
• A clickable index to Nikon View 4’s menus
• A guide to what to do when Nikon View 4 does not function as expected
• Instructions on reinstalling Nikon View 4
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Appendix A
Nikon View 4 Visual Index

The following pages provide a visual index to the Nikon View 4 menus.

The Transfer Images Window Menu Bar (Macintosh Only)

Appendix A: Nikon View 4 Visual Index

Transfer
Transfer images from the memory card
to the computer.

Quit
Quit Nikon View 4.
The other commands in this menu are
grayed out and unavailable when the
Image Transfer window is active.

Preferences…
Open the Preferences dialog.

The other commands in this menu are
grayed out and unavailable when the
Image Transfer window is active.  They
can be used in the Preferences and
other dialogs to cut, copy, paste, clear,
and select text, and to undo cut, paste,
and clear commands.

About Nikon View 4…
Display version information for Nikon
View 4. Help Center

Displays the help menu.

Show Balloons
Displays “Balloon Help”.

Nikon View 4 Help
Open the Nikon View 4 help file.
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The Thumbnail List Window Menu Bar (Windows)

Copy
Copy to the clipboard text selected
in the camera settings section or in a
text box.

Select
Select all transfer marked or transfer
unmarked, protected or unprotected
images.

Select All
Select all thumbnails.

Preferences…
Open the Preferences dialog.

View Image Folder(s)
When this item is checked, the folder
tree area will be displayed.

View Shooting Data
When this item is checked, the cam-
era settings section will be displayed.

Format card
Format the memory card inserted in
the camera, card slot, or card reader.

Open…
Open the selected image(s).

Transfer
Transfer the selected image(s) to the
computer.

Save copy of image
Save a copy of the selected image(s)
to disk.

Copy thumbnail list to file
Output the thumbnail list to disk as a
JPEG file.

Print Thumbnail List
Print the thumbnail list.

Print Image
Print the selected image(s).

Exit
Exit Nikon View 4.

Help Topics
Display Nikon View 4 help topics.

About Nikon View 4…
Display version information for Nikon
View 4.

Rotate
Rotate the selected image(s) ninety de-
grees clockwise or counter-clockwise.

Attribute
Change the protected or hidden sta-
tus of the selected image(s).

Delete
Delete the selected image(s) or folder.

Display Small Transfer Window
Closes the Thumbnail list window and
opens the Image Transfer window.
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The Thumbnail List Window Menu Bar (Macintosh)

About Nikon View 4…
Display version information for Nikon
View 4.

Open
Open the selected image(s).

Close
Close the active image window.

Transfer
Transfer the selected image(s) to the
computer.

Save copy of image
Save a copy of the selected image(s)
to disk.

Print Setup…
Display the print setup dialog for the
printer selected in the Chooser.

Copy thumbnail list to file
Output the thumbnail list to disk as a
JPEG file.

Print Thumbnail List…
Print the thumbnail list.

Print…
Print the selected image(s).

Quit
Quit Nikon View 4.

Undo/Cut/Copy/Paste/Clear
These commands are only active dur-
ing text entry in dialogs such as the
Preferences dialog, when they allow
you to use keyboard shortcuts to cut,
copy, paste, and clear text and undo
cut, copy, paste, and clear commands.

Select
Select all transfer marked or transfer
unmarked, protected or unprotected
images.

Select All
Select all thumbnails.

Preferences…
Open the Preferences dialog.

View Image Folder(s)
When this item is checked, the folder
tree area will be displayed.

View Shooting Data
When this item is checked, the cam-
era settings section will be displayed.

Zoom In/Zoom Out
Zoom images displayed in the built-in
viewer in or out.

Display Small Transfer Window
Closes the Thumbnail List window and
opens the Image Transfer window.
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Rotate
Rotate the selected image(s) ninety
degrees clockwise or counter-clock-
wise.

Protect
Change the protected status of the
selected image(s).

Delete…
Delete the selected image(s) or folder.

Format card…
Format the memory card inserted in
the camera, card slot, or card reader. Cascade

Arrange the Thumbnail List window
and image windows so that they over-
lap.

Thumbnail list
Activate the Thumbnail List window
and bring it to the front.

Open files
The files open in the built-in viewer
are listed at the end of the menu.

The Thumbnail List Window Menu Bar (Macintosh—continued)

Appendix A: Nikon View 4 Visual Index

Help Center
Display Mac OS help.

Show/Hide Balloons
Turn Balloon Help on and off.

Nikon View 4 Help
Open the Nikon View 4 help file.
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Appendix B
Troubleshooting

Should you encounter any problems using Nikon View 4, check the list below before contacting your retailer or Nikon representative.

Appendix B: Troubleshooting

Possible CauseProblem

Movies can not be played back
(Windows only)

  42• No movie player is selected in the Viewer tab of the Preferences dialog.

The thumbnail list is not displayed.
   9
  23
   8

• No memory card is inserted in the camera, card slot, or card reader
• No camera or card reader is selected in the folder tree.
• The card does not contain images taken with a Nikon digital camera.

Nikon View 4 does not start auto-
matically when a camera or card
reader is connected.

   9
   8

   8
  34
     —

• A memory card is not inserted in the camera or card reader.
• The images on the memory card were taken with a make of camera not supported under

Nikon View 4.
• The camera is not properly installed
• Auto launch: Disable is checked in the Auto launch tab of the Preferences dialog.
• Your computer is running Nikon Capture.

Life-Long Learning

As part of Nikon’s “Life-Long Learning” commitment to ongoing product support and education, continually-updated information is available on-line at the
following web-sites:
• For users in the United States of America: http://www.nikonusa.com/
• For users in Europe: http://www.nikon-euro.com/
• For users in Asia, Oceania, the Middle East, and Africa: http://www.nikon-asia.com/
Visit these sites to keep up-to-date with the latest product information and general advice on digital imaging and photography.  For more information, please
contact your nearest Nikon representative.

http://www.nikon-image.com/eng/

Can not find image files which
have been transferred to the
computer.

  35• A destination folder is not specified in the Transfer tab of the Preferences dialog.

http://www.nikonusa.com
http://www.nikon-euro.com
http://www.nikon-asia.com
http://www.nikon-image.com/eng/
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Macintosh

Step 1—Start the installer
After inserting the Nikon View 4 CD into the CD-ROM drive, click Install
Nikon View 4 in the Basic Software tab of the Welcome dialog.  The li-
cense agreement and ReadMe windows will be displayed; click Accept and
Continue… to proceed to the installer dialog shown in Step 2.

Appendix C
Reinstall

When Nikon View 4 does not function as expected (see Appendix B, “Troubleshooting”), it may indicate that you need to reinstall the program.  This
appendix describes how to uninstall and reinstall Nikon View on both the Macintosh and Windows platforms.

Reinstalling Nikon View 4
Before reinstalling Nikon View 4, you will need to uninstall the program.

Windows

Step 1—Uninstall Nikon View 4
From the Start menu, select Programs > Nikon View 4 > Nikon View 4
Uninstall.

Click here  to proceed to the next step.

Click here  to proceed to the next step.

Log On

When installing, uninstalling or using Nikon View 4, log on as the “Adminis-
trator” (Windows 2000 Professional) or “Computer Administrator” (Win-
dows XP Home Edition/Windows XP Professional).
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Macintosh
Step 2—Select the uninstall option
To start the process of uninstalling Nikon View 4, select Uninstall from
the pop-up menu in the top left corner of the installer dialog and then click
the Uninstall button at the bottom right corner of the dialog.

Step 3—Exit other applications
The dialog shown below will be displayed.  Click Continue to automati-
cally quit all other applications and continue the process of uninstalling
Nikon View 4.

Windows
Step 2—Confirmation
When the message, “Do you want to completely remove the selected ap-
plication and all of its components?” appears, click OK to begin the pro-
cess of uninstalling Nikon View 4.

Step 3—Shared components
If any of the components used by Nikon View 4 are also used by another
program, a confirmation dialog will be displayed.  Follow the instructions in
the dialog to remove the component or leave it untouched.

Click here  to proceed to the next step. Click here  to proceed to the next step.
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Windows
Step 4—Restart your computer
The dialog shown below will be displayed when the process of uninstalling
Nikon View 4 is complete.  Confirm that Yes, I want to restart my com-
puter now is selected and click Finish to restart your computer.

Step 5—Reinstall Nikon View 4
Reinstall Nikon View 4 as described in “Getting Started: Installation”(  7).

Macintosh
Step 4—Exit the uninstaller
Once the process of uninstalling Nikon View 4 is complete, the following
message will be displayed.  Click OK to exit the uninstaller.

Step 5—Restart your computer
Please restart your computer.

Step 6—Reinstall Nikon View 4
Reinstall Nikon View 4 as described in “Getting Started: Installation”(  7).

Pg. For more information on:

7 Installing Nikon View 4

Pg. For more information on:

7 Installing Nikon View 4
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